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. Oregon Department of Administrative Services

Director’s Office

155 Cottage Street NE U20
Salem, OR 97301

PHONE: (503} 378-3104
FAX: (503) 373-7643

Theodore R. Kulongoski, Governor

December 31, 2009

Senator Peter Courtney, Senate President
Representative Dave Hunt, Speaker of the House
900 Court St. NE

Salem, Oregon 97301

Re: Annual Report on Statewide Internal Audit Activities for the fiscal year ended June 30, 2009
Senator Courtney and Representative Hunt:

It is an honor to present to you the Department of Administrative Services’ (DAS) fifth annual
report on statewide internal auditing activities as required by Oregon Revised Statute (ORS)
184.360 (4).

This report contains information on the entities governing internal auditing in the state including
the Statewide Audit Advisory Committee (SAAC) and agency internal audit committees. It also
includes summaries of statewide internal audit activities occurring between July 1, 2008 and June
30, 2009 and administrative information such as vacancies, recruiting efforts, and professional
certifications of audit staff. Tables included delineate specific activities by agency including audit
reports issued, consulting engagements and other “value-added” work performed by the Internal
Audit functions.

SAAC members were provided an advance copy of this report for review. If you have questions,
or would like to obtain additional information, please contact me or Pamela Stroebel Valencia at
(503) 378-4037.

Sincerely,

[ S U Ve

Scott L. Harra, Director

Cc: Statewide Audit Advisory Committee Members
Directors and Chief Audit Executives of Agencies with an Internal Audit Function
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STATEWIDE INTERNAL AUDIT GOVERNANCE ATTRIBUTES
OAR 125-700-0025, 0035

The Institute of Internal Auditors (11A), a globally recognized organization, defines internal auditing as an
independent, objective assurance and consulting activity designed to add value and improve an
organization’s operations. It helps an organization accomplish its objectives by bringing a systematic,
disciplined approach to evaluate and improve the effectiveness of risk management, control and
governance processes.’

Oregon Revised Statute 184.360 dictates internal audit activities within state government be coordinated
to promote effectiveness. The Department of Administrative Services (DAS) was directed to adopt rules
setting standards and policies for internal audit functions within state government, which were established
as Oregon Administrative Rule (OAR) 125-700 Internal Auditing. Additionally, DAS is to annually
submit a report to the Joint Committee on Ways and Means or the Emergency Board describing internal
audit activities that have occurred in state government during the year; this report serves to meet that
requirement by providing information on how agency internal audit functions are meeting the components
of the law and the administrative rule.

During the Seventy-Fifth Oregon Legislative Assembly this law was revised to add requirements for
Executive department agencies required to have an internal audit function to:
e Produce risk assessments of their agencies in accordance with nationally recognized audit
standards;
e Use its risk assessment as the basis for the selection and performance of at least one internal
audit per calendar year;
e Audit a component of its governance and risk management processes at least once every five
years and file a report with DAS; and
o File completed risk assessments and internal audit reports with the Division of Audits of the
Office of the Secretary of State.

The purpose of this law and the revisions which become effective January 1, 2010 is to increase and
enhance the independence and professionalism of the internal audit function within state government.

! International Professional Practices Framework issued January 2009
? House Bill 3139



STATEWIDE AUDIT ADVISORY COMMITTEE
OAR 125-700-0012

The Statewide Audit Advisory Committee (SAAC) was created to promote excellence and professional,
standards-based internal auditing services in state government. SAAC serves in an advisory capacity to
the Director of DAS. It is comprised of members from state government and the private sector and meets
quarterly to discuss statewide audit matters and issues of interest. In Fiscal Year (FY) 2009 the following
members served on SAAC:

Scott L. Harra, Chair and DAS Director

Charles Hibner, Director, Oregon Audits Division (through February 2009, filled interim with
Will Garber and Drummond Kahn, through appointment of new Director)

Gary Blackmer, Director, Oregon Audits Division (since June 1, 2009)

Carol Welch, Vice President — Global Corporate Audit, Nike Inc.

Debbie Ferguson, Chief Audit Executive (CAE), Standard Insurance

Craig Stroud, Budget and Finance Manager, Oregon Zoo

Kingsley Click, Director, Judicial Department, (delegated to David Moon, CAE beginning
September 2008)

Clark Seely, Associate State Forester, Oregon Department of Forestry

John Radford, State Controller, DAS

Ken Rocco, Director, Legislative Fiscal Office (delegated to Dallas Weyand then Laurie Byerly,
Principal Legislative Analyst since January 2008)

Marlene Hartinger, CAE, Oregon Department of Transportation

Pamela J. Stroebel Valencia, CAE, DAS

SAAC performed a survey of the state’s internal audit community and affected agency management in
2006 and developed categories of issues to address to meet its charter objectives: Outreach, SAAC-CAE
Connection, Training, Coverage and Reporting. SAAC meets annually with the internal audit community
to update its Action Plan. Below is a summary of work performed on the Action Plan during FY 2009:

Outreach

Internal audit representatives continue to represent state government at various college and university
career events. Four agencies (Departments of Justice, Revenue, Veterans Affairs and the Oregon Liquor
Control Commission) sponsored internships in their internal audit functions during FY 2009. DAS
worked jointly with the Salem Chapter of the I1A to participate in the first career fair sponsored by the
state of Oregon and held a follow-up informational forum for potential internal audit candidates.

DAS revised SAAC’s website to encompass statewide internal audit topics more broadly. The new
website (located at: http://oregon.gov/DAS/IA/) can be used to share templates and examples of best
practices between agencies to potentially improve efficiencies in auditing across state government.

Three Committee members participated on a panel at a Salem Chapter 1A lunch event in March 2009.
The event allowed SAAC members to discuss their role on SAAC and share their views on internal
auditing in state government, as well as provided an opportunity for questions and answers from
interested participants.

SAAC-CAE Connection
The DAS CAE held quarterly meetings in conjunction with the state CAE’s to provide updates on SAAC
initiatives and receive input from the state’s internal audit community to bring back to SAAC.

In FY 2008, SAAC formed a workgroup of internal auditors, performance measure coordinators, and
Legislative Fiscal Office staff. This workgroup developed an audit program template for reviewing data
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integrity of performance measures, to provide a standardized way to meet the intent of the internal audit
administrative rule requirement in 125-700-0050 (5). The workgroup developed the template and 16
agency internal auditors volunteered to review 10 — 15 percent of their agency’s Key Performance
Measures. The work determined improvements could be made around documentation, controls, validation
of third party data, and use of data elements and assumptions in calculations for key performance
measures in nine agencies. The full statewide compilation report on this project was issued to the
members of the Seventy-Fifth Oregon Legislative Assembly on February 16, 2009 and can be found at:
http://www.leg.state.or.us/comm/Ifo/2009 _session/KPM_report.pdf. Eight agency internal audit functions
plan to perform follow-up work on findings and recommendations during FY 2010.

Reporting

A subcommittee was formed to begin drafting language to revise the OAR on internal auditing found in
section 125-700. One large change will be around allowing agencies within the state to perform External
Peer or Quality Assurance reviews of each other. This is a commonly accepted industry practice and
would allow agencies to meet professional auditing standards more cost effectively. By participating in
these reviews, internal audit staff will potentially recognize best practices for implementing professionally
recognized internal auditing standards within their own functions.

The subcommittee which included the LFO representative from SAAC as well as auditors from the
Departments of Transportation, Human Services and Administrative Services, also drafted a template to
create consistency in the annual internal audit reports submitted to DAS from agencies to comply with the
OAR.

Moving Forward
For FY 2010 SAAC'’s action plan includes these areas of focus:

e Revise the Internal Audit OAR to provide additional guidance and to simplify reporting for
agencies;

o Implement a self-assessment process;
Review and discuss potential training options for agency internal audit committee members;

o Re-open Request for Proposal to update list of contractors qualified to provide internal audit
services to state agencies;

o Compile best practices and potential statewide issues from FY 2009 annual internal audit activity
reporting for continuing discussions with the internal audit community; and

o Realize opportunities for partnering with other advisory committees with common themes and
purposes to increase awareness of risk management activities in state government; such as the
recently re-organized Risk Management Advisory Council and the Committee on Performance
Excellence created through Senate Bill 1099 (2008).



AGENCY AUDIT COMMITTEES
OAR 125-700-0035

Each agency required to have an internal audit function is also required to create and maintain an audit
committee to provide oversight of auditing and internal control for the agency and to help ensure the
independence of the internal audit function. Agencies are encouraged to include qualified members of
governing boards, commissions, individuals from outside their agency, or senior management officials
not directly responsible for the internal audit function to enhance public accountability and transparency.

Of the 27 agencies with an established internal audit function, 23 (85 percent) have audit committees with
an approved charter that meet on a regular basis. Nineteen of these agency committees have at least one
member external to the organization, seven are chaired by an external member, and three have audit
committees whose membership is fully comprised of external representatives. Audit Committee sizes
range from three to thirteen members and meeting frequency is generally quarterly (only two reported
meeting less frequently), with some meeting nearly monthly.

INTERNAL AUDIT REPORTING STRUCTURE WITHIN THE AGENCY
OAR 125-700-0045

In order for the CAE to maximize objectivity, the position should report administratively to the agency
head or designee and functionally to the audit committee. All but three agencies with an established
internal audit function stated the CAE (or equivalent position) reported to the Director or Deputy Director
level position within the Agency, and had full access to the audit committee. These three did not specify
the reporting relationship in their report.

AUDITING STANDARDS
OAR 125-700-0025

Of the 27 established internal audit functions in state government, 20 follow International Standards for
the Professional Practice of Internal Auditing issued by the I1A. Three follow Generally Accepted
Government Auditing Standards promulgated by the United States Government Accountability Office.
Two agencies reported following both sets of standards and two did not specify. Agencies who satisfy the
requirement for an internal audit function with a contractor should specify professionally recognized
standards to be followed in the contract. Internal auditors who perform audits of specific topics, such as
information technology, may follow a specialized set of standards to conduct such work. Those standards
should be specified in the audit report.

SUMMARY OF INTERNAL AUDIT ACTIVITIES FOR FY 2009
OAR 125-700-0020, 0050, 0055

The following 31 agencies currently meet the criteria in OAR 125-700-0020 requiring an internal audit
function (biennial expenditures exceed $100,000,000; number of Full Time Equivalent (FTE) employees
exceeds 400; or dollar value of cash items processed annually exceeds $10,000,000) or have created an
internal audit function without qualifying under the criteria. Of the 31 agencies required to have an
internal audit function, 27 have an established internal audit function with internal audit duties at least
minimally assigned to staff and 1 is solely using contracted resources to meet the requirement. The
Departments of Fish and Wildlife and Business Oregon will be contracting for internal audit services in
FY 2010; the Department of Agriculture has no assigned staff or contract in place.



Information contained in the table is as of June 30, 2009. DAS received annual activity reports from all of
the agencies required to report.

Administrative Services 2 0 Yes 2006/2011
Agriculture 0 0 Last N/A

conducted in

2004

Community Colleges & Workforce 5 0 No N/A
Development
Consumer & Business Services 1 0 Yes 2004/2009
Corrections 4 0 Yes 2005/2010
Business Oregon 0 N/A No N/A
Education 1 0 Yes N/A/2009
Employment 1 0 Yes 2005/2010
Energy 1 1 No N/A
Environmental Quality 5° Contract Yes N/A
Fish & Wildlife 0 N/A No N/A
Forestry 1 0 Yes N/A/2009
Housing & Community Services 1 0 Yes N/A/2013
Human Services 10 2 Yes 2006/2011
Judicial Department 3! 1 Yes No
Justice, Department of 14 0 Yes N/A/2012
Liquor Control Commission A15%° Contract’ Yes N/A/2013
Lottery 4 0 Yes 2005/2010
Military 4 1 Yes 2008/2011
Parks & Recreation 1 0 Yes N/A/2014
Public Employees Retirement System 3 0 Yes 2005/2010
Public Utility Commission 15 .05 Yes N/A
Revenue 2 0 Yes N/A/2010
State Lands 1 0 Yes N/A/2012
State Police 1 0 Yes N/A/2013
Student Assistance Commission 0 Contract Yes N/A
Transportation 6 1 Yes 2008/2011
Treasury 2 0 Yes 2007/2012
Oregon University System 11 0 Yes 2006/2011
Oregon Youth Authority 1 1 No N/A/2011
Veterans Affairs 1° 1 Yes N/A/2010
TOTAL 64.3 8.05

® Required every 3 or 5 years (standard dependent)

* In addition to regular FTE, had a developmental or intern position for at least part of the fiscal year

® Not formal internal audit staff

® Also has some IA related consulting work performed from another position
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STAFFING

Turnover and Recruiting

Seven of the agencies with established internal audit functions (26 percent) had open internal audit
positions at the end of FY 2009 (total FTE is down .95 from the end of FY 2008); an additional four
agencies had at least one internal audit vacancy at some point during the year.

Department of Energy established an internal audit function in FY 2008 with a part-time internal auditor
and received an approved Policy Option Package in the 2009-2011 budget for a permanent internal audit
position. The Department will recruit to fill the position in FY 2010. The Oregon Parks and Recreation
Department re-established its internal audit function in FY 2009 after a failed recruitment in the previous
year. The Oregon Youth Authority’s internal audit position was vacant for the full fiscal year, but an
Internal Auditor was hired early in FY 2010. The Department of Environmental Quality hired a temporary
Internal Auditor to complete a specific risk assessment in FY 2010; an internal audit position has been
approved but the agency lacks the funding to hire a full-time position.

The Department of Community Colleges and Workforce Development (CCWD) had a part-time internal
audit function during FY 2008 and made a request to fill a full-time position in its 2009-2011 budget,
which was not approved. CCWD plans to make a similar request for the 2011-2013 biennium. Both the
Department of Fish and Wildlife and the Oregon Liquor Control Commission requested full-time
positions in their 2009-2011 budget requests, but both requests were denied by the Budget and
Management Division of DAS. The Department of Agriculture and Oregon Liquor Control Commission
have also been unable to secure budget resources for an internal audit position. The Department of Justice
brought forth a Policy Option Package for an additional internal audit position which was also not
included in the Governor’s Recommended Budget for the 2009-2011 biennium.

Some agencies lost positions due to budget reductions which will reduce internal audit work performed in
those agencies (total internal audit positions reported are down 2.55 from FY 2008; some of these
reductions do not become effective until FY 2010):
o DAS lost its Senior Internal Auditor position, one of three internal audit positions, effective April
1, 2009.
e The Department of Education lost its only internal audit position effective July 25, 2009.
Education will contract out audit work to meet the OAR requirement.
e The Judicial Department lost two of its three internal audit positions as well as its developmental
position early in FY 2010.
e Oregon University System lost two of five audit supervisor positions.

Professional Certifications and Advanced Degrees

Of the 27 agencies who reported having staff assigned to internal audit positions during FY 2009,
21 (78 percent) reported having at least 1 staff member who held a professional designation or
advanced degree (some staff members hold more than 1). The following percentages of
employees hold these designated professional certifications (some percentages are down from
what was reported for FY 2008 due to the decrease in internal audit staff across state
government):

FY 2009 FY 2008

Certified Public Accountant (CPA) 34 percent 38 percent
Certified Internal Auditor (CIA) 20 percent 26 percent
Certified Information Systems Auditor (CISA) 19 percent 14 percent
Certified Government Audit Professional (CGAP) 12 percent 9 percent
Certified Fraud Examiners (CFE) 11 percent 8 percent
Certificate in Public Management (CPM) 3 percent 2 percent
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Three additional staff members have passed the CPA exam and are awaiting certification. Additional
certifications held by at least one internal audit member in state government include: Certified Investment
Derivative Auditor (CIDA), and Certificate in Control Self-Assessment (CCSA).

Also within the audit community, the following percentages of employees hold these advanced degrees:
FY 2009 FY 2008

Masters in Business Administration (MBA) 17 percent 5 percent
Masters in Public Administration (MPA) 6 percent 2 percent

Additional Masters Degrees held by internal audit staff in FY 2009 include: Public Policy, Management,
Educational Leadership, Economics and Accounting. One internal auditor also holds a law degree, Juris
Doctor. Two agencies each reported having one staff member currently working on an MBA.

Of the internal auditors in state government, 67 percent (up from 60 percent reported for FY 2008) hold at
least one professional designation or advanced degree.

Professional Organizations

Approximately sixty (93 percent) of reported internal auditor staff in Oregon state government are
members of the I1A. Auditors from the Departments of Corrections, Administrative Services, Judicial,
Justice, and Oregon University System served on the Salem Chapter Board of the I1A during FY 2009.
The Internal Auditor at State Police performed the Annual Review of the Chapter’s Revenue and
Expenses for the chapter year which ended in May 2008.

Other memberships in professional organizations held by at least one internal auditor in Oregon state
government include (most associated with professional certifications held or related to a specific agency’s
mission): Oregon and American Societies of Certified Public Accountants, Oregon Public Performance
Management Association, Association of Certified Fraud Examiners, Government Finance Officers
Association, Information Systems Audit and Control Association, Association of Public Pension Fund
Auditors, Project Management Institute, and Association of College and University Auditors.

In addition to holding memberships in professional organizations, several agencies have auditors who
participate on national committees and provide training to other groups:

e DAS: The CAE is a volunteer instructor for the 11A and provided training at three public sector
seminars during FY 2009 at various locations nationwide. She also provided training to the Salem
Chapter of the I1A on audit report writing in plain language and updates to the I1A’s standards.
Additionally, she presented on performance auditing at the Oregon Public Performance
Management Association’s 4" Annual Performance Measurement Conference in July 2008.

o Department of Corrections: The CAE provides training to state auditors on the electronic audit
work-papers software package utilized by many internal audit functions in the state.

e Lottery: Internal Audit is a member of the North American State and Provincial Lottery
Association (NASPL) Audit Sub-committee. The Chief Internal Auditor provided a presentation
on the Oregon Lottery’s Quality Assurance and Improvement Program at the annual NASPL
Audit Sub-committee meeting. The purpose of the presentation was to educate the audience on
I1A standards and to encourage participation in the NASPL Audit Subcommittee External Quality
Assessment program; and she participates in activities of the Sub-committee to improve internal
auditing in state and provincial lotteries.

e Oregon University System: A representative serves on the Association of College and
University Auditors Nominating committee.

o Department of Transportation: A representatives serves on the Association of State Highway
and Transportation Officials Administrative Sub-committee on Internal and External Auditor’s
Peer Review Committee.



QUALITY ASSURANCE OR PEER REVIEWS
125-700-0055

State internal audit functions should have an external peer review in accordance with the professional
standards they follow. The 11A’s International Professional Practices Framework requires an external
quality assurance review every five years and the requirement under the United States Government
Accountability Office’s Generally Accepted Government Auditing Standards is for an external review to
be performed every three years.

The Oregon Department of Transportation’s external peer review was completed in March 2009 and
resulted in a rating of ‘complies’ with the Peer Review Bylaws and other guidelines of the American
Association of State Highway and Transportation Official Standing Committee on Administration,
Administration Subcommittee on Internal and External Audit as well as Generally Accepted Government
Auditing Standards. The review covered the period June 1, 2006 through June 30, 2008 and the fieldwork
was conducted in August 2008. One minor observation was noted and the response included plans to
monitor for future compliance. The next external review will be due in 2011.

The following agencies are out of compliance with the external review requirement:

e Department of Education — Because the internal audit function was eliminated as part of the
budget reduction process, the agency’s Audit Committee determined there would be little value
derived from obtaining an external quality assurance review of the function.

e Oregon Judicial Department — The external review was due in June 2006 but due to 100 percent
turnover in internal audit staff, including the CAE the review was postponed so sufficient work
from the current team would be available for the review. The agency entered into contract
negotiations during the beginning of 2009 to have a review performed. However, the current
budget crises prevented them from completing that process. Now they are working on an
agreement to have the review performed by internal auditors form other state agencies and expect
this will be complete during FY 2010.

The 11A’s International Professional Practices Framework requires the CAE to develop and maintain a
quality assurance and improvement program which must also include internal assessments of all aspects
of the internal audit activity. Two agencies completed internal reviews during FY 2009:

o Lottery performed self-assessments, both in 2007 and 2009 which resulted in a conclusion of
generally complies. All but one of the recommendations for improvements in efficiency and
effectiveness has been implemented and the final recommendation is underway.

e The Military Department completed a Quality Assurance Internal Review in May 20009.



SUMMARY OF WORK PERFORMED IN FY 2009

Audit Reports Issued

125-700-0040

Agency Name of Audit’ Date Issued
Administrative » Performance Measures — Data Integrity » September 31, 2008
Services Audit

» Follow-up of Prior Audit Recommendations » March 23, 2009
» Small Purchase Order Transaction System
Program Audit » March 23, 2009
» Department-Wide Cash Handling Audit:
Controls Over Cash Appear to be Adequate » June 30, 2009
Consumer & Business > Internal Control over Disbursements > July 9, 2008
Services » Key Performance Measures 2, 10 and 11 » October 9, 2008
» Receivership Assets » March 16, 2009
» Purchasing Review » May 23, 2009
Corrections » Criminogenic Risk Factor Assessment » August 12, 2008
Audit
» SPOTS Audit » October 24, 2008
> Extortion Audit » January 27, 2009
» KPM Audit > September 22, 2008
» Canteen Purchasing Audit » February 5, 2009
» Suicide Prevention Follow-up Audit » May 19, 2009
Education » Audit Follow-up Report » February 9, 2009
» Small Purchase Order Transaction System > April 1, 2009
Compliance
Employment » SPOTS » December 15, 2008
» Key Performance Measures » October 13, 2008
» Portable/Removable Storage Devices > May 2008
» Sub-Recipient Monitoring > June 2009
Environmental Quality » Vehicle Inspection Program Oregon Identity » June 2009 (reported
Theft Protection Compliance September 2009)
Fish & Wildlife » Sub-Recipient Monitoring Review > July 22,2008
Forestry » Audit of Data Integrity for Selected Key » October 2008
Performance Measures
Housing & Community » Rental Security Deposit Interest Earned > July 11, 2008
Services Review
» Internal Audit Assessment of Oregon » August 27, 2008
Housing and Community Services
performance Measurement System
» Debt Management Section Process » September 30, 2008
Efficiency and Effectiveness Review
» Small Purchase Order Transactions System » October 24, 2008
Follow-up Review
» Review of Financial Controls for Housing » February 9, 2009

Division

" Titles and descriptions of Audit Reports, Consulting Engagements and Other Value-Added Activities included in

this report are copies directly from agency reports to DAS on annual internal audit activities.
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Agency

Name of Audit’

Date Issued

» Data Integrity and Accuracy (Reports are » June 8, 2009
Accurate and Consistent)
Human Services » Employment Related Day Care > September 23, 2008
» MD Critical Incident Response Re: » December 23, 2008
Urinalysis
» Critical Incident Response Safety Plan > July 31, 2008
» Key Performance Measures » July 18, 2008 and
June 29, 2009
» Contract Delegation > September 23, 2008
and June 24, 2009
» Critical Incident Response Follow-up > February 24, 2009
» Information Technology Project Cost > June 29, 2009
Benefit Analysis Methodology
Judicial Department » Washington County Circuit Court — Data > September 17, 2008
Security Audit
» Supreme Court Law Library — Financial > September 24, 2008
Controls Review
» Lane County Circuit Court — Data Security » September 17, 2008
Audit
» Seventh Judicial District — Data Security > September 17, 2008
Audit
» Law Enforcement Data System — Internal » November 10, 2008
Controls Review
» Business and Fiscal Services Division — > April 27, 2009
Oregon Judicial Information Network
(Online) — Internal Controls and Revenues
Review
> Business and Fiscal Services Division — > June 24, 2009
Cell Phone Usage Review
Justice, Department of » Small Purchase Order Transaction System » December 2008
(SPOTS) Audit
» Audit of Safeguards for Handling > February 2009
Cash/Checks (Salem Office)
Liquor Control » Follow-up Review on prior audit > Issued: June 27,
Commission recommendations: Information Security 2008; Follow-up:
Risk Assessment July 2, 2008 —
October 1, 2009
» Small Purchase Order Transaction System » December 8, 2008
(SPOTS) Audit
» Oregon Liquor Control Commission’s > June 25, 2009
Licensing Function Lacks Accountability
and Effective Oversight
Lottery » Contract Administration Audit > July 17, 2008
» Employee Recognition and Incentives Audit > September 12, 2008
» Audit Follow-up » December 11, 2008
» Laptop Computer Security Audit > February 11, 2009
» Powerball Lockdown Procedures Audit » May 20, 2009
» Continuous Monitoring of the Retailer » August and
Management System December 2008
» Continuous Monitoring of the Epicor » August and
System December 2008;
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Agency Name of Audit’ Date Issued
March and June 2009
Military » Personal Clothing Accountability » December 4, 2008
» Report of Survey Process — Supply » May 4, 2009
Operations Retail
» Ammunition Accountability Follow-up » March 31, 2009
Parks & Recreation » Travel Compliance Review > June 5, 2009
» Purchasing Card Compliance Audit » May 29, 2009
Public Employees » Benefit Calculation Audit » August 15, 2008
Retirement System » PERS Health Insurance Program Risk > August 8, 2008
Assessment
» Performance Measures Data Integrity » September 15, 2008
» Small Purchase Order Transaction System > September 8, 2008
(SPOTS) Card
» Access to Sponsor Connect > November 10, 2008
» Annual Earnings Crediting Process » November 14, 2008
» Small Purchase Order Transaction System > April 23, 2009
(SPOTS) Card
» Electronic Funds Transfer > April 28, 2009
» Member Purchases at Retirement » May 15, 2009
Public Utility » Periodic review of DAS SPOTS cards » March 5, 2009
Commission » Performance review of Oregon Universal > April 23, 2009
Service Fund 3™ Part Administrator
Revenue » KPM Review Audit » August 2008
» Other Agency Accounts Internal Control » October 2008
Audit
» SPOTS » December 2008
» Pipeline (Processing Center) Memo » January 2009
» PIT Refund Approval and Auto Approval > April 2009
Audit
State Lands » Review of Open Accounts used by South > May 4, 2009
Slough National Estuarine Research
Reserve and Bend offices at the Department
of State Lands
State Police » KPM - Data Integrity Review > September 30, 2008
» Follow-up Review of SOS Findings > February 2, 2009
» Ammunition Review » March 13, 2009
» SPOTS Review » May 6, 2009
Transportation > Additional Controls and Documentation » October 15, 2008
Would Reinforce ODOT’s Performance
Measurement System
» ODOT’s IT Procurement Structure Lacks > November 4, 2008
Effective Oversight
» Competitive Practices and Oversight for IT » November 4, 2008
Procurements Could Be Improved
» ODOT’s Treatment of Independent » November 4, 2008
Contractors Is Not In Compliance with State
Rule and ODOT Policy
» SPOTS Card Annual Compliance Review: » November 11, 2008

Overall Usage Appropriate, but Additional
Analysis and Documentation of Credit
Limits Needed
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Agency Name of Audit’ Date Issued
» Maintenance District 1 Allegations — Most > April 13, 2009
Anonymous Claims Lacked Evidence, but
Management Weaknesses Exist
Treasury » Operational Review of the Oregon Public » December 2008
Employees’ Retirement Fund
» Investment Valuation and Financial » December 8, 2008
Reporting Audit
» Preparation for the New Treasurer & > December 16, 2008
Administration Audit
» Internal Controls Audit of Investment » March 31, 2009
Portfolios
» Public Equity Internal Controls Audit » March 31, 2009
Oregon University » Engineer Equipment > July 21, 2008
System » Athletic Department Financial Reports > August 4, 2008
» Campus Building Security » August 6 and
October 24, 2008
» Performance Evaluations » August 15,2008
> Performance Measures » August 22, 2008
» Perkins Loan Programs » October 15, 24 and
December 8, 2008
» Outside Employment Policy > November 4, 2008
» Banner Forms Security » October 28 and
December 22, 2008
» Football Attendance Certifications » February 11, 2009
» USAID Grant » February 19, 2009
» GEAR UP Grant » March 27, 2009
» Student Payroll > April 14, 2009
> International Students > April 14,2009
» Faculty Outside Employment » May 27, 2009
» Pharmacy Inventory » May 27, 2009
» Facilities Purchasing > June 16, 2009
Veterans Affairs » Klamath County Veterans’ Service Office > July 1, 2008
Follow-up Audit
» Oregon Veterans’ Home Contractor » September 22, 2008
Expenses Audit
» Department Battle Book » October 7, 2008
» Performance Measures Audit » October 21, 2008
» Lake County Veterans’ Service Office » October 31, 2008
Audit
» Department Credit Card Audit » January 14, 2009
» Performance Appraisals Audits > April 3, 2009
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Consulting Activities

Consulting services are advisory and related client service activities, the nature and scope of which are
agreed upon with the client and which are intended to add value and improve an organization’s
governance, risk management, and control processes without the internal auditor assuming management
responsibility. Examples include counsel, advice, facilitation, and training.

Agency

Name of Consulting Activity

Administrative Services

Chief Audit Executive provides Ethical-Decision Making training to
DAS New Employee Orientation and Human Resource Services
Division’s New to State Management course

Senior Internal Auditor held informational meetings with Agency
Division leadership to learn about DAS business functions and
discuss opportunities for providing audit services in the future
Chief Audit Executive participates on various DAS and statewide
committees including: DAS Information Technology Governance
Council, Risk Management Advisory Council, Executive Steering
Team and a sub-committee for the State Procurement Office’s
Strategic Improvement Project and State Data Center Chief
Information Office Advisory Board

Community Colleges &
Workforce Development

A\

Sub-recipient monitoring for WIA federal grant awards passed
through to local areas, such as community colleges and non-profit
organizations; involves reviewing the Single-Audit reports to
identify instances of questioned costs. Assist program staff in
conducting annual program and fiscal monitoring of the
Department’s seven Local Workforce Investment Area offices and
certain lower level sub-recipients as required by Title 1B of the WIA
of 1998.

Assist and train the CCWD fiscal staff in the timely completion of
fiscal year end financial and federal grant reporting to DAS State
Controller’s Division.

Review contracts between the community colleges and Joint
Apprenticeship Training Committees to determine compliance with
contract terms and OARs; determine accuracy of enrollment and
course completion by student apprentices’ reported to the college.
Perform audit of Commissioner’s travel expense claims and time
reporting/payroll expenditures as required by Oregon Accounting
Manual policy 10.90.00.

Consumer & Business
Services

Site specific cash handling counsel

Contract review and advice

Governance counsel

Policy process and review

Audit process and planning consultation

Purchasing review

Facilitation to promote resolution of confidential information on
specific reports

Financial data change process resulting in policy changes to
strengthen internal controls

Fund use consult

Corrections

YV V|V VYV VVVVVVY

POV Mileage Reimbursement — approximately every six months
Internal Audit reviews personal mileage reimbursements.
Conducted three fraud investigations
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Agency

Name of Consulting Activity

YV WV VYV

Researched and responded to SOS Fraud Waste and Abuse calls.
Sat in an independent advisory capacity on various committees (i.e.
IT Committee)

Provided guidance on application of the Oregon Ethics Law on a
number of occasions

Provided data and analysis used for determining inmates’ ability to
pay for cost of care

Education

Y VvV

Periodic follow-up reports with advice on open audit findings
Quarterly reports on status of State School Fund audit Corrective
Action Plan

Employment

VVVY V VYV V

Address Cross-Match — periodic review of Employee/Ul Benefit
Recipient Address Match Report

Fraud Review — Assist with investigation of misuse of confidential
information by staff

Trade Act Fraud Review — Assisted with Trade Act Fund Abuse
Review and Follow-up

Fragmented Purchase Review - Investigated fragmented purchases
Use of Time Code Review — Investigated misuse of time codes
Loss of Funds Review — Investigated possible loss of funds

Use of Fake Agency Letterhead — Reviewed and counseled on
course of action to be taken

Fish and Wildlife

Financial Close Process Risk Assessment
Payment Card Industry Standard Risk Assessment
Automated Clearing House Risk Assessment

Forestry

Department Strategic Planning and Management Model
Department Business Continuity Planning
Fire Payroll Error Elimination and Control Improvement

Housing & Community
Services

Cash Processing

Mail Receipts processing

HOME Investment Partnerships program regulations

Oregon Affordable Housing Tax Credit financial reconciliation
process

Implementation of Davis-Bacon Requirements

Enterprise Risk Management Implementation

Legal Document processing

Implementing controls related to American Reinvestment and
Recovery Act requirements

Travel policy requirements

Introduction to Auditing/Risk Management processes

Human Services

Behavioral Rehabilitative Services

Electronic Imaging of Accounting Documents

Blue Mountain recovery Center Medicaid Cost Report FY 2008
Financial Review

Eastern Oregon Training Center Medicaid Cost Report FY 2008
Financial Review

Sunset Empire Transportation District

Judicial Department

YV V V|V ¥V VVV|IVV VVVV VVVVVVYVYVVYYVY

Appellate Court Services Division, Law Library — Cost/benefit
analysis of record storage

Office of the State Court Administrator — Review of security
proposal regarding key-card duties

Umatilla County Circuit Court — Check stock ordering and storage
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Agency

Name of Consulting Activity

consult
Appellate Court Services Division, Publications — Develop revenue
and expenditure targets

Justice, Department of

A\

ACH Risk Self-Assessment Facilitation

“Best Practices for Internal Controls: Effective
Management/Supervisory Review” Reference Sheet for Risk
Management and Cost Savings

Policy Review/Comment: SB583 Compliance, PCI Compliance, IT
Security, Loss Reporting, Security Incident Response, Cash
Handling

Internal and External Audit Follow-up

Fraud Prevention Program

Risk Self-Assessment Training (Fiscal Services)

Options and Techniques for Annual SPOTS Compliance Review

Liquor Control
Commission

An Assessment of the Key Performance Measures of the Oregon
Liguor Control Commission — August 2, 2008

Public Safety and Agency Performance — August 22, 2008

New Public Safety Key Performance Measure and LFO
Requirements — February 4, 2009

10-Year Strategic Planning Schema — August 28, 2008
Business Continuity Planning: Project Management — FY 2009
Business Metrics for Policy Option Packages — Agency Request
Budget for 2009-11

Fiscal Impact Statements — 2009 Legislative Session

NW Retail Liquor Price Comparisons — March 2009

Liguor Agency Compensation Studies — January-May 2009

Lottery

VIVVYVY VYVV VYV V|VVVY

April 2009 Internal Audit Overview presentation to Lottery Retail
Operations employees. Two IA staff members provided a total of
five training sessions designed to help employees understand the
role of Internal Audit at the Oregon Lottery

May 2009 Internal Controls in Balance presentation to Lottery
managers. The Chief Internal Auditor made this presentation to
inform management of the COSO internal control framework; define
risk and control and teach the importance of balancing the two; and
teach about the different types of control activities

Project Teams. Served on various project teams including the
following: Prize Integrity, Consumer Identify Protection, Scratch It
for Schools, Raffle, Silent Whistle Hotline, and Consumer
Promotions. This work resulted in improvements to Oregon Lottery
processes and improved the internal auditor’s understanding of
ongoing operations

Policy review. Reviewed various Lottery-wide and departmental
policies and procedures under development

ERP system. Participated in the review of three different ERP
systems and provided input during the procurement process as to
which system appeared to provide for enhanced controls and
auditability. Participated in needs analysis to define the requirements
for new ERP system

Instant Ticket Contracts. Reviewed and suggested revisions to
instant ticket vendor contract language related to auditing

Military

Cooperative Agreement Management Control Checklist
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Agency

Name of Consulting Activity

Public Employees » Quality Assurance
Retirement System » Information Security
» Other various consulting requests throughout the year
Revenue » ACH audit questionnaire for Treasury
» Access Management Project
» Agency Security Plan
» Hardware and Software Inventory process review
» IRS safeguard review
» ISBRA
» IT systems — retention of prior versions
» Payroll controls — timesheet submissions
» Program Evaluation — CAFFA
» Proper use of the Internet
» Video Conferencing vs. Webinar, Controls and Security
State Lands » Review of internal controls and consulting on multiple activities
including, but not limited to: Accounting for the purchase and sale
of automobiles, Use of “reduction of expense” transactions; Travel
reimbursement; Payroll distribution; Revenue subsidiary ledger
reconciliation
» Review of land purchase transactions
» Review and consulting on DSL Business Continuity Plan
State Police » Motor Carrier Safety Assurance Program Interagency Agreement
Student Assistance » Moss Adams assisted OSAC Management with the development of
Commission a Disaster Recovery and Business Continuity Plan
Transportation » Provided consulting services to several ODOT departments on a
wide variety of issues, ranging from Public Transit issues, to
reviewing contract language for the Office of Innovative
partnerships, assisting Region 5 regarding simulation techniques and
providing the Local Agency Section with information about A-87
indirect cost allocation plans. Assisted other state agencies by
performing internal audit functions at OLCC and assisting the
Secretary of State Audits Division. Assisted local governments by
consulting about billing rates
Oregon University System » Consulted and followed up on campus data security beaches
» Training efforts included: Presented internal control sessions

including financial Stewardship Institute held for campus business
officers and presented compliance risks for ARRA to executive
councils and the Board
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Other Value-Added Activities

Internal Audit functions have added value and assisted management in making improvements to the
operations and performance of the agency’s programs. In addition to the types of consulting and other
activities described previously, a few specific examples of activities performed in FY 2009 are as follows:

Agency Description of Value-Added Activity

Administrative Services » CAE coordinates the Statewide Audit Advisory Committee and holds
quarterly meetings of the state’s Chief Audit Executives in conjunction
with the Salem Chapter 11A’s CAE Coordinator

» Performed a review for the Oregon Parks and Recreation Department
and issued a management letter with recommendations for improvement
to controls over payroll processes in January 2009

» Performed limited work with the Oregon State Payroll System on
handling small terminated employee payroll balances and issued a letter
on December 10, 2008

» Provides consulting and support services to agency management
receiving external audits

» CAE worked with originators of HB 3139 and agency internal auditors
to revise original bill language and provide testimony to Senate and
House Committees on the bill and internal auditing in state government

Agriculture Although no formal internal audit position exists, the agency has

implemented the following continuous improvement processes:

» SPOTS - Developed training materials for agency staff on the proper
procedures for purchasing and reporting SPOTS card transactions; made
training available both online and in house

» Travel Committee — Established to review ways to improve travel
reporting procedures as well as expense sheet processing times

» Administrative Retreat — Annual review of agencies performance to
determine if the agency is meeting internal and external goals and
objectives

» Fleet Rate Review — External review performed by Mercury and
Associates to review replacement cost recovery procedures for the
agencies fleet

Community Colleges & » Assist program staff, LWIA personnel, and the Attorney General’s

Workforce Development Office in performing audit resolution on questioned costs reported as the
result of three incident reports filed with the Department by former
employees of a Workforce Oregon One Stop Career Center

» Establish procedures for review of federal funds received and expended
under the American Recovery and Reimbursement Act which included
visiting a subrecipient in order to determine proper expenditures of funds

» Assist in the establishment of funds and accounting structure, and review
of legal documents and act as liaison for the Department with officials of
the local community colleges, DAS, State Treasurer’s Office and the
Department’s Project Manager to implement legislation for the sale of
general obligation and lottery bonds to finance, in part, community
college capital construction projects, including “Go Oregon” projects

» Act as liaison with Audits Division and their contractors and federal
agency auditors on current audit engagements

» Reviewed proposed legislation for the 2009-11 biennium to determine
potential financial, legal, and internal control implications and the need
for policies and procedures
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Agency

Description of Value-Added Activity

Consumer & Business
Services

YV VvV VY V

A\

The Internal Auditor serves on various internal committees to provide
pro-active consulting services and keep up-to-date on current issues
facing the Department, such as: Information Resource Steering
Committee; Information Security Subcommittee; and Data Steward
Subcommittee

Provided mentoring services regarding audit processes to a division
planning to begin jurisdictional reviews

Provided coordination and mentorship to managers performing
interagency required audits

Provided formal and informal information to managers regarding
internal controls and governance

Identified potential economy for management consideration and
provided updates noting success

External Audit Coordination for the Statewide Audit of Selected
Financial Accounts

Corrections

A\

Y

Act as liaison with external auditors

Provided assistance to the Idaho Department of Corrections as they
determined how to design an Internal Audit unit with the agency
Issued agency-wide messages discussing such topics as proper
authorizations, signature authority, supervisory review, etc

Education

Assisted management in closing audit findings

Forestry

Department Training on Oregon Ethics Law
Leadership Team Planning Group

Housing & Community
Services

Review of service diversity in Housing programs
Follow-up on corrective action taken to findings
Personnel investigation review

Human Services

V|IVV V|V V|V

VVVYVYVYVYVY

Coordinated 11 separate Secretary of State, Audits Division external
audits

Participated in 15 federal reviews

Coordinated follow-up efforts on prior audit and review findings
Provided support to OR-Kids Child Welfare automated system design
Provided review for provider settlements/issues

Presented as part of department management training efforts
Consulted Business Integrity Experts

Participated in Administrative Services Division Information Systems
Committee

Judicial Department

A\

Y

Review various division specific and Department-wide policies under
development

Participate in various committees to provide Internal Audit controls
perspective, including: e-Court committees, Policy and Law committees,
and physical and information security committees

The CAE has been delegated the responsibility to attend the Statewide
Audit Advisory Committee (SAAC) to promote excellence and
professional standards in internal auditing for state government

Justice, Department of

Promoted fraud awareness and prevention

Developed a Department intranet page about the internal auditing
function. Developed a Department intranet page about internal auditing.
Described the nature and benefits of internal auditing and the Audit
Committee, and promoted risk management tools

Developed Internal Audit Operating Manual

Provided input for employee security awareness
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Agency

Description of Value-Added Activity

Coordinated Audit Committee meetings and provided information as
requested. Presented updates on internal and external audit activities
Evaluated computer-assisted auditing tools

Completed fiscal impact analysis for proposed IA legislation

Liquor Control Commission

Strategic Planning Facilitation

Lottery

VIVIVYV V¥V

The Lottery is a member of the Multi-State Lottery Association
(MUSL). The Chief Internal Auditor participated in an audit of MUSL to
provide member lotteries’ management with reasonable assurance that
the process of establishing jackpot amounts and related liabilities, and
the funds provided by each lottery as a result thereof, were adequately
controlled and accurately calculated. Issued September 2008

Developed and administered a contract for a SAS 70 Audit of a major
service provider. The SAS 70 audit results provided assurance to the
Lottery and the Secretary of State’s Audits Division that the service
provider’s internal controls were suitably designed, in place and
operating effectively

Developed and administered contracts for Security Reviews of three
ticket vendors. The reviews provided the Lottery with assurance that the
ticket manufacturing security at all three vendors is excellent

Chief Internal Auditor is an external member of the Oregon Department
of Education’s Audit Committee

Public Employees Retirement

System

Y

A\

Introduced management to the beginning stages of an Enterprise Risk
Management methodology

CAE serves as Information Security Officer and chairs Information
Security Board Meetings

Revenue

Non voting member of ITSP committee
Non voting member of Management Issues Committee
Liaison for Secretary of State Audits

State Lands

Y V|V VYV

Risk management incident tracking and claim reporting

Work with the Risk Management Advisory Council to reach out to all
Oregon State agencies, and to provide a forum for stakeholders to
exchange information, generate ideas, and make recommendations to
DAS Risk Management in accordance with the Advisory Council
Operation Guidelines

State Police

KPM Committee Duties
OSP Legislative Bill Review Team

Oregon University System

External audit liaison with federal and state agencies to provide synergy
of services
Administered Financial Concerns Hotline and reporting

Veterans Affairs

Y|V V|IVVY

Y VY

Analyzed financial information from 34 counties to determine if state
pass-through dollars were being spent appropriately

Investigated a loss of funds incident

Assisted in development of legislation for criminal background checks
for Department employees

Participated in a committee to develop policies and procedures for a new
state veterans’ program — Small Business Repair Loan Program
Participated in a committee to complete the PCI and ACH risk
assessments required by the Oregon State Treasury

Worked as audit liaison between the Department, Secretary of State
Audits Division and the contracted financial statement audit team
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